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Introduction to Data Model Document Generation 

This is a technical whitepaper on how to generate the data dictionary documentation for Oracle 
Financial Services Analytical Applications (OFSAA) as well as the Oracle Financial Services 
Data Foundation (OFSDF). The process of generating the download specifications for OFSA 
Staging is also explained. Both these activities are performed in ERWin. 
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Background on ERwin 

OFSA data models are present in ERwin. ERwin also helps in the creation of data model 
documentation. 

OFSAA Data Models in ERwin 

Since OFSAA version 5, the data model has been defined and delivered as an ERwin file. ERwin is a 
data modeling tool or environment on which, OFSAA currently depends. It is used to define all data 
model artifacts, both Logical and Physical data models, which are used by the OFSAA applications, as 
well as the Oracle Financial Services Data Foundation.  

Impact of ERwin use on data model documentation 

In the prior versions of OFSAA, the data model was documented in PDF form, and shipped separately 
from the actual application artifacts. Starting from OFSAA 5, this has changed. The primary store of all 
data model related documentation will be the ERwin data model file. The reasons for this are as 
follows:  

1. ERwin permits complete definition of model-related documentation within the model itself. 
In other words, the model is now ‘self-documenting’.  

2. In many cases, clients typically perform several customizations to the model. This causes any 
fixed model documentation to progressively become outdated or inaccurate, as additional 
fields or tables are added to the data model for client-specific needs. 

3. All OFSAA applications share a common physical data model, which is also shipped as part of 
the OFSDF. As clients may license independent OFSAA applications or OFSDF at different 
points in time, ERwin permits these models to be merged in a controlled manner to account 
for site-specific changes as well as release-specific changes from Oracle. 

Model documentation can then be generated for the combined, updated model, and therefore stays 
up-to-date with both the latest internal (client-specific) and external (product-driven) changes. 

Purpose of this whitepaper 

This whitepaper explains the process of generating two important documentation artifacts from within 
ERwin. 

Data Dictionary 

The data dictionary is a detailed listing of all tables/columns constituting a specific OFSAA 
application. Today, the ERwin file containing the OFSAA data models provides the following 
information relevant to the creation of a data dictionary: 

• Subject Areas in each part of the data model 

A subject area is a specific grouping/organization of the data model content. It is a high-level 
categorization scheme that shows which application module or business analysis areas are 
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served within the model. The tables and columns defined during the design process are 
grouped into these categories for easier navigation as well as comprehension of the model. 

• Table/Entity definitions 

o Detailed definitions of all tables 

o Detailed, column level dictionary information including column specification, 
datatypes, as well as several User Defined Properties (UDPs) that provide additional 
metadata added during the design process to categorize a specific data model object. 

• Data Model diagrams 

o Associated with each data model (either OFSAA or OFSDF) is a collection of data 
model diagrams (Entity Relationship diagrams). These are usually specific to a subject 
area, and provide a visual representation of the key entities, their relationships and 
keys. 

Download Specifications 

As indicated earlier, the OFSAA data model is a common data model supporting multiple OFSAA 
applications. The organization of the data model is split into 3 distinct areas. 

 

1. Staging Area: This schema is the common data sourcing layer across all OFSAA applications, 
and also the OFSDF.  
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2. Processing Area: This refers to application-specific schemas that are exclusive to each OFSAA 
application, and provide storage/structures for intermediate outputs and application-specific 
configuration and setup data. 

3. Results Area: This refers to the collection of star schemas with conformed dimensions that 
support BI/reporting from aggregated outputs from the processing area. 

The use of the common sourcing layer means that a single table in the staging area can serve multiple 
and different analytical applications/processing engines within the OFSAA architecture. 

Therefore, it is necessary to know how specific applications map to specific staging tables/columns, 
and what subset of the complete unified staging data model is actually used by each application. 

The download specification is a supplemental document to the data dictionary that provides this 
listing. For each staging table/column, it provides key information such as definition, datatype, and so 
on. Additionally, it maps each column in a specific staging table to the OFSAA 
applications/components that use this column, and also indicates whether this column is mandatory or 
optional.  

This provides implementers with a scoping documentation for data sourcing that specifies the data 
requirements applicable to a particular solution, for which the sourcing scripts need to be developed. 

This is done by means of specialized metadata within ERwin called User Defined Properties (UDPs), 
which are additional tags that a data model designer can attach to any data model object in ERwin. For 
additional details on UDPs please refer to the ERwin Data Modeler documentation. 

Generation Process 

In order to produce the specific documentation described earlier, you can make use of ERwin’s Model 
Reporting Capabilities, which allows data modelers to produce customized reports of various data 
model artifacts. 

ERwin allows the generation of model-documentation in various levels of detail, and various formats 
like HTML, Text, PDF, and so on. 

The generation process involves installing ERwin reporting templates for the Data Dictionary and 
Download Specification, and executing these templates, with customization of the outputs as required. 

Note: This guide is not an exhaustive User guide for ERwin’s reporting capabilities, but only details 
the specific steps to apply them to generate OFSAA/OFSDF documentation. Please refer ERwin 
documentation or Contextual Help within ERwin for more details. 
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Requirements for Data Model Document Generation 

1. ERwin version 7.x 

2. Latest documentation templates 

• Data Dictionary template can be found here- 
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Diagram_And
_Dictionary.rtb 

• Download Specification template can be found here - 
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Download_Sp
ec_Report_Template.erp 

• Pre-formatted Excel Spreadsheet can be found here - 
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/DL_Spec_Ou
tput_Container.xls 

3. The data models  

Generating the Data Dictionary 

Step 1: Download the latest template 

The latest Data Dictionary template is available at 
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Diagram_And_Dictionary.rtb. 
It has a file extension .rtb (report template builder). 

Step 2: Open the corresponding data model for which documentation needs to be generated, from 
within ERwin. 

• Make sure that your model is up-to-date before generating documentation. Verify that the 
model for which you are generating the dictionary reflects the latest changes (Refer to model 
merge documentation for details on this process). 

o Specific to your institution 

o Latest product-release specific changes 

Step 3: Locate and open the template from within ERwin. To do so, use the following menu 
navigation to open the Report Builder dialog in ERwin. 

http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Diagram_And_Dictionary.rtb
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Diagram_And_Dictionary.rtb
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Download_Spec_Report_Template.erp
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Download_Spec_Report_Template.erp
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/DL_Spec_Output_Container.xls
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/DL_Spec_Output_Container.xls
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Diagram_And_Dictionary.rtb
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Make sure you use a single consistent location for installing all your data dictionary templates, and 
remove any old templates prior to the next step. 

Step 4: Using the Browse… button from within the Report Builder, navigate to the folder containing 
the downloaded template. Click Diagram_And_Dictionary.rtb as shown in the following screenshot. 

 

Step 5: Using the Edit button, change (if necessary) the following: 
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1. Location of the output HTML files/folders under the Export tab. The default is the same 
place as the downloaded template. 
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2. Formatting (if required): You can change formatting at a global level under Edit >Preferences 
in the Report Builder dialog box or at a template level under Edit >Properties. 

 
Step 6: Execute the template by clicking the Run icon, which is the icon with the arrow 
pointing downward.  
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This should result in the ‘Available Subject Area and Stored Displays’ dialog box asking for which 
Stored Displays you want to generate the documentation. This is essentially a list of all ER diagrams 
by subject area that is part of your current model.  

Select the ones you wish to generate, and additionally adjust the scaling factor to make the attributes 
legible. See the following diagram for reference. 

Note: If the subject area diagram is too large; that is, if you choose the scaling, then the generation of 
the picture may fail. Therefore, you may need to iterate a few times to achieve the ‘right’ scaling factor 
for the diagram that makes it both visible, as well as, reasonably sized. 
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Step 7: Click OK in the ‘Available Subject Area and Stored Displays’ dialog box. This should continue 
the report run and finally generate a HTML page which has a left-hand navigation frame with each of 
the selected subject areas chosen in step 6. 
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Clicking each will open up the corresponding diagram that is generated as jpeg and clicking an entity 
will open up the corresponding entity’s HTML page showing the attributes. The arrow at the far right 
for an attribute, under the ‘Column’ column, will take you to the corresponding physical column 
definition with datatype, length, and so on. For example, the following screenshot shows this for the 
Account Number attribute in the Stage CASA Accounts Table, and its corresponding physical column 
definition (v_account_number). 

 

 

 

Step 8: You can customize the HTML output with stylesheets if required. This requires HTML/CSS 
knowledge. 

Generating Download Specifications for Staging Area 

Step 1: Download the latest template and associated pre-formatted Excel workbook container. You 
need Excel version 97-2003 or later. 

Note: The latest Download specification template is available at 
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Download_Spec_Report_Temp
late.erp 

The extension is .erp (ERwin reports). This is a different template facility than the one used for Data Dictionary 
documentation. 

Step 2: Open the latest version of the Staging Data Model from which you want to generate the 
Download Specification. 

All tables in the staging data model are either prefixed with ‘STG_’ or ‘Stage’ in the logical entity view. 

Step 3: Verify that the User Defined Properties (UDPs) exist in the model. To do so, switch to the 
physical view by selecting this from the dropdown menu as shown in the following screenshot. 

 

http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Download_Spec_Report_Template.erp
http://docs.oracle.com/cd/E26650_01/books/CommonDocuments/Download_Spec_Report_Template.erp


Data Model Document Generation  

 

12 

Now, double click any table in this view, to open up the details dialog box showing the detailed listing 
of columns for the table. Select any column, and scroll to the right, to the UDP tab. Click the tab. This 
should show you a list of UDPs applicable to that column. You should see something like the 
following screenshot. 

 

 

 

In case you do not see the UDPs listed, recheck if you have the right version of the latest staging 
model.  

Following table lists the Column UDP Names based on the specific financial services Applications like 
ALM, FTP, PFT, and so on. 

 

Column UDP Name Application Full Name 
ALM ALM Asset Liability Management 
FTP FTP Funds Transfer Pricing 
GL ReconR GL ReconR General Ledger Reconciliation 

ICAAP ICAAP Internal Capital Adequacy 
Assessment Process 
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Column UDP Name Application Full Name 
MR Var MR Var Market Risk 
PFT PFT Profitability 

ROREC ROREC Operation Risk and Economic 
Capital 

RP RP Retail Pooling 
BASEL_I BASEL Basel 
BASEL_II_BIS_MR_IMM BASEL Basel 
BASEL_II_BIS_MR_STD BASEL Basel 
BASEL_II_BIS_NON_SEC_AIRB BASEL Basel 
BASEL_II_BIS_NON_SEC_FIRB BASEL Basel 
BASEL_II_BIS_NON_SEC_STD BASEL Basel 
BASEL_II_BIS_OR_ALT_STD BASEL Basel 
BASEL_II_BIS_OR_BIA BASEL Basel 
BASEL_II_BIS_OR_STD BASEL Basel 
BASEL_II_BIS_SEC_STD BASEL Basel 
BASEL_II_IFSB_MR BASEL Basel 
BASEL_II_IFSB_NON_SEC BASEL Basel 
BASEL_II_IFSB_OR BASEL Basel 
BASEL_II_IFSB_SEC BASEL Basel 
BASEL_II_INDIA_MR_STD BASEL Basel 
BASEL_II_INDIA_NON_SEC_STD BASEL Basel 
BASEL_II_INDIA_OR BASEL Basel 
BASEL_II_INDIA_SEC_STD BASEL Basel 
BASEL_II_USA_NON_SEC BASEL Basel 
BASEL_II_USA_SEC BASEL Basel 
HM HM Hedge Management 

LLFP LLFP Loan Loss Forecasting & 
Provisioning 

LRM LRM Liquidity Risk Management 

CREC CREC Credit Risk and Economic 
Capital 

BASEL_II_BRAZIL_NON_SEC_STD BASEL Basel 
BASEL_II_BRAZIL_OR_ALT_STD BASEL Basel 
BASEL_II_BRAZIL_OR_BIA BASEL Basel 
BASEL_II_BRAZIL_OR_SIMPLE_AL
T_STD BASEL Basel 

ESTCP ESTCP Enterprise Stress Testing 
Capital Planning 

CR CR Credit Risk 

CIRCA CIRCA Customer Insight Retail 
Customer Analytics 

CIIPA CIIPA Customer Insight Institutional 
Performance Analytics 
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Column UDP Name Application Full Name 

CIRPA CIRPA Customer Insight Retail 
Performance Analytics 

CICA 
CICA Customer Insight Channel 

Analytics 

Mantas-AML Mantas-AML Mantas Anti Money 
Laundering 

Mantas-FR Mantas-FR Mantas Fraud 
Mantas-TC Mantas-TC Mantas Trade Compliance 
Mantas-BC Mantas-BC Mantas Broker Compliance 
BASEL_III_BIS_NON_SEC_AIRB BASEL Basel 
BASEL_III_BIS_NON_SEC_FIRB BASEL Basel 
BASEL_III_BIS_NON_SEC_STD BASEL Basel 
BASEL_III_BRAZIL_NON_SEC_STD BASEL Basel 
BASEL_III_IFSB_NON_SEC BASEL Basel 
BASEL_III_USA_NON_SEC BASEL Basel 
BASEL_III_BIS_CAP_STRUCT BASEL Basel 
BASEL_III_INDIA_NON_SEC_STD BASEL Basel 

ALMBI ALMBI Asset Liability Management 
Business Intelligence 

OIPA OIPA Oracle Insurance Performance 
Analytics 

BASEL_II_BRAZIL_OR_ALT_STD BASEL Basel 
BASEL_II_BRAZIL_OR_BIA BASEL Basel 
BASEL_II_BRAZIL_OR_SIMPLE_AL
T_STD BASEL Basel 

Oracle Insurance Solvency II Analytics 
Oracle Insurance 
Solvency II 
Analytics 

Oracle Insurance Solvency II 
Analytics 

BASEL_III_USA_SEC_IRB BASEL Basel 
MR MR Market Risk 

QMR QMR Qualitative Management 
Reporting 

EFPA EFPA Enterprise Financial 
Performance Analytics 

BASEL_III_USA_CAP_STRUCT BASEL Basel 
IFRS IFRS  
BASEL_II_BIS_CAP_STRUCT BASEL Basel 
BASEL_II_BIS_SEC_RBA BASEL Basel 
BASEL_II_BRAZIL_CAP_STRUCT BASEL Basel 
BASEL_II_BRAZIL_MR_STD BASEL Basel 
BASEL_II_CBRC_CAPITAL BASEL Basel 
BASEL_II_CBRC_MR BASEL Basel 
BASEL_II_CBRC_NON_SEC BASEL Basel 
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Column UDP Name Application Full Name 
BASEL_II_CBRC_OR BASEL Basel 
BASEL_II_CBRC_SEC BASEL Basel 
BASEL_II_IFSB_CAPITAL BASEL Basel 
BASEL_II_INDIA_CAPITAL BASEL Basel 
BASEL_II_USA_CAP_STRUCT BASEL Basel 
BASEL_III_BIS_LEVERAGE_RATIO BASEL Basel 
BASEL_III_BIS_SEC_IRB BASEL Basel 
BASEL_III_BIS_SEC_SFA BASEL Basel 
BASEL_III_BIS_SEC_STD BASEL Basel 
BASEL_III_USA_LEVERAGE_RATIO BASEL Basel 
BASEL_III_USA_SCP_EXP_LMT BASEL Basel 
BASEL_II_INDIA_NON_SEC_STD BASEL Basel 
BASEL_II_BIS_REPORTING BASEL Basel 
BASEL_III_BIS_REPORTING BASEL Basel 
   

 

 

Note: If a table UDP of an App is updated as ‘yes’, then all PK columns should be considered as DL-
MAN in the download specifications. 

To add the UDPs specific to an application, you need to edit your template, 
Download_Spec_Report_Template.erp.  

To edit the template,  

• Select Tools, Data Browser, Reports, and then select Open Report File.  

• In the dialog box that opens, navigate and select Download_Spec_Report_Template.erp. The 
template, Download_Spec_Report_Template.erp appears under Table Reports in the left 
side. See the following screenshot. 



Data Model Document Generation  

 

16 

 
 

• Right click Download_Spec_Report_Template.erp and edit the template. 

• Click the Columns and UDPs in the template and select the UDPs based on the application. 

Step 4: Make sure the Excel Workbook (DLSpecContainer.xls) is open, and cell A1 is selected. This is 
necessary because you will be using the DDE facility to directly output to a pre-configured/pre-
formatted Excel workbook. Alternatively, you can save the output of the ERwin as a csv file and open 
it in Excel, but you will have to handle the formatting by yourself in this case. 

Step 5: Navigate to Data Browser under the Tools menu. 
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This will open up a separate window for the Reporting Data Browser, which looks like following 
screenshot. From here, click Reports then click the Open Reports File. 

 

Locate the downloaded template and click it, to load the template. Your left view should look like the 
following screenshot: 

 

Step 6: Double click the template to execute it. This will generate a result set on the right, which looks 
like the following screenshot: 
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Step 6b (Optional): You can perform a lot of additional formatting such as changing the column names 
and ordering by right clicking the result set in the left pane and choosing ‘Edit Report Format’. 

 

Step 7: Once you are done with setting the formatting options for the output, from the File menu, click 
‘Export’ to bring up the Export dialog box. From the dropdown list, select DDE. In the Presentation 
section, select ‘Tabular with Duplicates’. Check, ‘Export headings’. 
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Before clicking Export…, ensure that the downloaded Excel workbook 
DL_Spec_Output_Container.xls is open, and cell A1 is selected. 

Now click, Export…. You will see a list of open Excel worksheets. Select 
DL_Spec_Output_Container.xls and wait for the operation to complete. This can be slow, especially 
for larger models. 
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Conclusion 

Factors like customizations, different license purchases, and so on, made the data model document 
generation a challenge. However, the model reporting capabilities of ERwin to come up with 
customized documentation in different formats has helped in developing the data model documents 
like data dictionary and download specifications, quite easier. With the help of templates, it is now 
possible to create data dictionaries for OFSAA and OFSDF. Similarly, with another set of templates, it 
is feasible to have download specifications for OFSAA Staging area.  
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Appendix A 

User-defined properties are set for tables and columns within ERwin.  
 
The following user defined properties can be set for the column: 
 
UDP Name Description List of values 

Balance Range Property to identify if the column 
within a table classified as ‘PA 
Lookup Table’ needs to be 
displayed under ‘Range’ within 
Lookup table definition. 

YES / NO 

Balance Property to identify if the column 
is of type ‘Balance’. 

YES / NO 

Standard Rate Property to identify if the column 
is of type ‘Standard Rate’. 

YES / NO 

Balance Weighted Object Property to identify if the column 
is of type ‘Balance Weighted 
Object’. 

YES / NO 

Processing Key Property to identify if this column 
is used as a ‘Processing Key’ within 
the instrument, transaction and 
ledger_stat table. 

YES / NO 

Multiplier Related Field Property to specify the name of the 
column that is used to store the 
multiplier for the corresponding 
‘Frequency’ column. This property 
is used in Filters UI within 
OFSAAI. 

Text 

Related Field Property to specify the name of the 
column that is used to store the 
multiplier for the corresponding 
‘Term’ column. This property is 
used in Filters UI within OFSAAI. 

Text 

Term Multiplier Property to identify if the column 
is used to store ‘Term’. This 
property is used in Filters UI within 
OFSAAI. 

YES / NO 

Column Alias Property to specify an alias for the 
column. This is used within the 
staging loader program for loading 
LEDGER_STAT table. 

Text 

Transfer Pricing Output Property to identify if the column 
needs to be set as an alternate 
output column for writing transfer 
rates by transfer pricing engine. 

YES / NO 

Option Cost Output Property to identify if the column 
needs to be set as an alternate 
output column for writing option 

YES / NO 
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UDP Name Description List of values 

costing output by transfer pricing 
engine. 

Other Adj Spread Output Property to identify if the column 
needs to be set as an alternate 
output column for writing other 
adjustment spread by transfer 
pricing engine. 

YES / NO 

Other Adj Amount Output Property to identify if the column 
needs to be set as an alternate 
output column for writing other 
adjustment amount by transfer 
pricing engine. 

YES / NO 

 
 
Note: The user-defined property DT/FE/DT1 is not used within EPM applications. 
This property was introduced to categorize each attribute as Download (DL)/ Front-end (FE) / 
Computed through data transformation (DT). This property is used by ERM applications. This 
property may be discontinued and will be replaced by application specific user-defined properties to 
identify if the column is mandatory during download (DL-MAN) or optional during download (DL-
OPT) or not required to be downloaded (DL-NO). 
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Appendix B 

If you have applications that are qualified on FSDF 7.4.1.0.0, then use the following Template 
to generate DL-SPEC/Data Dictionary: 

 
 
If you have applications that are qualified on FSDF 7.4.2.0.0, then use the following Template: 
 

 
The new excel based template will enable user to generate both the data dictionary as well as 
the download specification using a single template. If you do not select any UDP’s in the 
selection form, then the template will generate the Data dictionary only, and if the UDP’s are 
selected , then it will generate DL-SPEC + Data Dictionary.  
 
Perform the below steps to do the same:  
 

1. Ensure that the Erwin Data Modeler version is Erwin 9 or later 
2. Ensure macros are enabled in this excel before execution 
3. Open the OFSAA data model in Erwin 9 or a later version before executing this template 
4. Click the button below to launch the UDP selection Menu 
5. Select the appropriate application UDP's(optional) and click on "Generate Report" button 
6. On successful execution, the following message is displayed "Report generation is Complete" 
7. Find the download specification and the data dictionary report in "OFSAA_Download_Spec" worksheet 

 


Instructions

		OFSAA DATA MODEL DICTIONARY AND DOWNLOAD SPECIFICATION TEMPLATE

		1) Ensure that the Erwin Data Modeler version is Erwin 9 or later

		2) Ensure macros are enabled in this excel before execution

		3) Open the OFSAA data model in Erwin 9 or a later version before executing this template

		4) Click the button below to launch the UDP selection Menu

		5) Select the appropriate application UDP's(optional) and click on "Generate Report" button

		6) On successful execution, the following message is displayed "Report generation is Complete"

		7) Find the download specification and the data dictionary report in "OFSAA_Download_Spec" worksheet



UDP Selection Menu



OFSAA_Download_Spec

		





adanayak
File Attachment
OFSAA Data Model Dictionary Template - FSDF 741.xls


Instructions

		OFSAA DATA MODEL DICTIONARY AND DOWNLOAD SPECIFICATION TEMPLATE

		1) Ensure that the Erwin Data Modeler version is Erwin 9 or later

		2) Ensure macros are enabled in this excel before execution

		3) Open the OFSAA data model in Erwin 9 or a later version before executing this template

		4) Click the button below to launch the UDP selection Menu

		5) Select the appropriate application UDP's(optional) and click on "Generate Report" button

		6) On successful execution, the following message is displayed "Report generation is Complete"

		7) Find the download specification and the data dictionary report in "OFSAA_Download_Spec" worksheet



UDP Selection Menu



OFSAA_Download_Spec

		





adanayak
File Attachment
OFSAA_Data_Model_Dictionary_Template_FSDF_742.xls
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